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ABSTRAKT 

Cílem této bakalářské práce je seznámit se 

s různými typy konstrukčních provedení rotorů 

synchronních reluktančních motorů (RSM), 

zhotovení modelů strojů a provedení vhodných 

simulací. V rámci této práce jsou ve 

vývojářském prostředí Ansys Electronics 

Desktop vytvořeny srovnatelné modely RSM. 

Závěr práce se zabývá porovnáním vlastností 

mezi modely podle výsledků z analýzy. 

Klíčová slova: Synchronní reluktanční motor, 

RSM, Ansys Electronics Desktop, Ansys RMxprt, 

Ansys Maxwell 2D, Ansys Motor-CAD 

ABSTRACT 

The purpose of this bachelor thesis is to get 

acquainted with different types of designs of 

synchronous reluctance motor (SynRM) rotors, 

to make machine models and to perform 

appropriate simulations. Within the thesis, 

comparable SynRM models are created in the 

Ansys Electronics Desktop development 

environment. The conclusion deals with the 

comparison of properties between models 

according to the results of the analysis. 

Keywords: Synchronous reluctance motor, 

SynRM, Ansys Electronics Desktop, Ansys 

RMxprt, Ansys Maxwell 2D, Ansys Motor-CAD
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Úvod 
V dnešní době je čím dál větší zájem o synchronní reluktanční motory (RSM). Díky pokrokům ve 

výzkumu se v současnosti objevily různé konstrukce RSM, které mají všelijaké vlastnosti. RSM jsou 

točivé elektrické stroje využívajícího reluktančního momentu pro vzájemnou přeměnu elektrické a 

mechanické energie. Rotor je složen z paketu lisovaných plechů, do kterého se poté vyřezávají 

magnetické bariéry tak, aby měl co největší poměr magnetického odporu v příčné vůči podélné ose. 

Tvarem magnetické bariéry omezíme tok v příčné ose a vytvoříme tok v podélné ose. Jelikož je rotor 

bez vinutí, nevznikají zde žádné činné ztráty na rozdíl od asynchronních strojů. 

Cílem této práce je ve vývojovém prostředí Ansys modelovat RSM s dvěma různými rotory a 

porovnat jejich odlišné vlastnosti. Práce začíná vysvětlením základních vlastností RSM pro pochopení 

principu činnosti motoru. Dále se zabývá různými typy rotorů RSM a kvalitativními parametry pro 

porovnání vlastností modelovaných motorů. Prozkoumaná je také problematika dovoleného oteplení. 

Následuje pak samotný návrh motoru s využitím statoru třífázového asynchronního motoru a simulace 

v prostředí Ansys RMxprt. Poté je popsáno vytvoření modelu v Maxwell 2D a provedena analýza. Po 

porovnání rotorů podobné konstrukce následuje analýza v Motor-CAD pro ověření tepelné správnosti 

návrhu spolu s pokusem o analytické řešení tepelné analýzy pro porovnání dovoleného oteplení. V 

závěru je pak provedeno zhodnocení výsledků z analýz a porovnání vlastností rotorů mezi sebou.  
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1. Synchronní reluktanční motor 
V této kapitole je představeno konstrukční provedení rotorů synchronních reluktančních motoru. 

Popíšu zde některé důležité vlastnosti, které je třeba znát, aby bylo možné motory správně vyhodnotit 

a porovnat. Ke konci této kapitoly se také zmíním o dovoleném oteplení a problémy s tím spojenými. 

1.1 Reluktanční moment 
Moment klasického synchronního stroje se skládá z momentu reluktančního a synchronního. 

Vztah pro moment m-fázového motoru je dle [1]: 

𝑀 =
𝑚

𝜔1𝑚

𝑈 ∙ 𝑈𝑖𝑓

𝑋𝑑
sin𝛿 +

𝑚 ∙ 𝑈2

𝜔1𝑚 ∙ 2
(
1

𝑋𝑞
−

1

𝑋𝑑
) sin2𝛿. (1-1) 

RSM však nemá budicí vinutí, a proto využívá pouze reluktančního momentu pro přeměnu 

elektrické energie na mechanickou. Vztah pro moment RSM je tedy možné vyjádřit ve tvaru: 

𝑀𝑟𝑒𝑙 =
𝑚 ∙ 𝑈2

𝜔1𝑚 ∙ 2
(
1

𝑋𝑞
−

1

𝑋𝑑
) sin 2𝛿. (1-2) 

V této rovnici je výraz (1/𝑋𝑞 − 1/𝑋𝑑)  rozdílem reaktancí v podélné a příčné ose. Moment 

můžeme také vyjádřit pomocí indukčností v podélné ose Ld a příčné ose Lq. Rovnice momentu je pak 

po úpravě dána vztahem [2]: 

𝑀 =
3

4
𝑝𝑝(𝐿𝑑 − 𝐿𝑞)𝐼𝑠

2 sin2𝛿. (1-3) 

Z předchozích vztahů pak plyne jeden z hlavních parametrů RSM, a to je poměr indukčností či 

reaktancí v podélné a příčné ose: 

𝜉𝑋 =
𝑋𝑑
𝑋𝑞
, (1-4) 

𝜉𝐿 =
𝐿𝑑
𝐿𝑞

. (1-5) 

Proto je snaha u RSM vytvořit tvarem rotoru, pokud možno co největší rozdíl indukčností. 

Indukčnost je úměrná převrácené hodnotě magnetického odporu, neboli reluktance, a proto se 

tomuto momentu říká reluktanční moment. 

1.2 Konstrukce RSM 
Na první pohled je patrné, že u RSM zcela chybí rotorové vinutí, tedy RSM pracuje bez buzení. 

Rotor je založen pouze na konstrukčním provedení z vhodně tvarovaných plechů, případně může 

obsahovat vložené permanentní magnety, aby se docílilo maximálního reluktančního momentu. 

Z tohoto důvodu nemá RSM ohmické ztráty v rotoru. 

Na rozdíl od spínaného reluktančního motoru má RSM stejný počet pólů na statoru i rotoru. 

Konstrukce magnetického obvodu statoru i statorové vinutí je stejné jako u asynchronních či klasických 

synchronních strojů. Svojí konstrukcí si tedy zanechal RSM některé výhody, které má spínaný 

reluktanční motor, a přitom se zbavil i několika nevýhod. Jedná se hlavně o problém s hlukem a pulsací 

momentu. Tyto problémy se těžko překonávají u spínaných reluktančních motorů, ale u RSM je to 

možné dosáhnout například změnou vinutí statoru, které neustále vytváří točivé magnetické pole, či 



3 
 

geometrií rotoru. Kvalitativní parametry může tedy mít lepší či horší, záleží hlavně na samotné 

konstrukci rotoru [3]. 

Jak již bylo zmíněno v  části 1.1, důležitým parametrem je geometrie stroje, přesněji řečeno 

rozdílná reluktance v osách d a q (Obr. 1). Jelikož chceme dosáhnout co největšího poměru indukčností 

v obou osách, je zapotřebí mít v ose d vysokou indukčnost 𝐿𝑑 v porovnání s indukčností v ose q. 

Této vlastnosti dosáhneme, pokud budou bariéry vyříznuty do plechu rotoru v takové podobě, 

aby v ose d byla velká magnetická vodivost a v ose q malá magnetická vodivost. Úhel mezi osami pak 

záleží na počtu pólů [4]. 

Obr. 1: Osy d a q pro čtyřpólové rotory RSM, převzato z [5]. 

1.3 Typy rotorů 
Typ rotoru záleží na způsobu vrstvení plechů rotoru. Plechy a bariéry mohou být buď axiálně 

laminované (ALA), nebo radiálně laminované (TLA). Jedná se o podélnou či příčnou osu vrstvení 

vzhledem k ose hřídele (Obr.2). Existuje také rotor s vyniklými póly, avšak ten má špatné vlastnosti, a 

proto se již neuvažuje jeho použití [3]. 

Obr. 2: Typy rotorů RSM a) s vyniklými póly, b) axiálně laminovaný rotor, c) radiálně laminovaný rotor, 

převzato z [6]. 

1.3.1 Axiálně laminované rotory 
Na první pohled se mohou zdát axiálně laminované a radiálně laminované rotory velmi podobné, 

pokud se podíváme na řez motoru. Obě konstrukce mají několik podobně vypadajících bariér, avšak 

pokud prozkoumáme způsob konstrukce laminace, všimneme si, že u ALA rotoru je zapotřebí 

natvarované plechy a bariéry připevnit k sobě pomocí šroubů. Tento způsob konstrukce pak přináší 

větší mechanické namáhání a také vyšší zvlnění momentu. Jelikož tento typ rotoru je vyráběn z plechů, 

které jsou na sebe naskládané podélně, je tak vytvořena plocha, v níž vznikají poměrně vysoké ztráty 

vířivými proudy. Bariéry přitom nejsou vzduchové, ale většinou z epoxidu [4]. 
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1.3.2 Radiálně laminované rotory 
Radiálně laminované rotory jsou oproti ALA rotorům sestaveny pouze z na sebe naskládaných 

elektrotechnických plechů, přičemž jsou bariéry většinou vyřezány pomocí laseru. Jedná se tedy hlavně 

o vzduchové bariéry. 

Plechy jsou přitom vyřezány do diskového tvaru a po naskládání na sebe jsou slisovány k sobě, 

aby vytvořily jeden rotor. Tady také vidíme jednu z výhod TLA rotoru, který oproti ALA rotoru má 

mnohem jednodušší způsob výroby. 

Jak již bylo naznačeno u ALA rotoru, TLA rotory lépe snáší mechanické namáhání, přesto se do 

bariér vyřezávají takzvané bariérové můstky, které mají napomáhat ke snížení mechanického 

namáhání způsobeného setrvačnými silami. Problém je však s materiálem. Bariérové můstky jsou 

vyráběny často z elektrotechnické oceli, ze které je vyroben i rotor. Proto jimi může procházet 

magnetický tok. Tím se původní cesty magnetického toku rozptýlí a zvýší se tak indukčnost v ose q a 

sníží v ose d, což je nežádoucí [7]. 

Optimalizace geometrie TLA rotoru je velmi obtížná. Obsahuje totiž mnoho parametrů, které 

jsou navzájem propojené a změna jednoho může ovlivnit několik kvalitativních parametrů najednou. 

Znamená to tedy, že změnou jednoho parametru jako je počet pólů můžeme způsobit značnou změnu 

účiníku, účinnosti i ovlivnit zvlnění momentu [8]. 

1.3.3 Cut-Off rotor 
Pokud by měla poslední bariéra „uříznutou“ vnější část, dostaneme takzvaný Cut-Off rotor 

(Obr. 3). Je vidět, že tato struktura oproti předchozím konstrukcím nemá zcela hladký rotor. Struktura 

Cuf-Off rotoru by měla sice snížit v ose q indukčnost, ale snižuje přitom také indukčnost v ose d [9]. Je 

tu tedy podobný problém jako v předchozí konstrukci. 

Obr. 3: Cut-Off struktura rotoru převzato z [10]. 

1.4 Kvalitativní parametry motoru 
Točivé stroje mají několik kvalitativních parametrů, které můžeme využít pro porovnání 

vlastností mezi dvěma podobnými konstrukcemi. V této práci se zaměřím na dva z nich, které bude 

možné v simulaci zobrazit. Jedná se o zvlnění momentu a účiník. 

1.4.1 Zvlnění momentu 
Jedním z důležitých kvalitativních parametrů je zvlnění momentu. Jedná se o kvalitativní 

parametr, který je neodlučitelnou součástí RSM, přesto velmi nežádoucí. Pokud by totiž bylo zvlnění 

momentu příliš velké, docházelo by k vibracím, a tím pádem k mechanickému namáhání 
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motoru.  V důsledku vibrací by motor způsoboval také hluk, jelikož by se „klepal“. Zvlnění motoru je 

definováno následujícím vzorcem, kde Mavg je průměrná hodnota momentu, Mmax je maximální 

hodnota momentu a Mmin je minimální hodnota momentu [11]: 

𝑀𝑧𝑣𝑙 =
𝑀𝑚𝑎𝑥 −𝑀𝑚𝑖𝑛

𝑀𝑎𝑣𝑔
∙ 100. (1-6) 

1.4.2 Účiník 
Účiník je dalším ze stěžejních parametrů. Účiník cos ϕ je bezrozměrná veličina udávající poměr 

činného výkonu P a zdánlivého výkonu S:  

cos𝜑 =
𝑃

𝑆
. (1-7) 

Pokud bychom chtěli určit maximální účiník, pak s využitím poměru indukčnosti je možné maximální 

hodnotu účiníku vyjádřit ve tvaru [12]: 

cos𝜑𝑚𝑎𝑥 =
𝜉𝐿 − 1

𝜉𝐿 + 1
. (1-8) 

1.5 Dovolené oteplení 
Dalším důležitým parametrem u motorů je dovolené oteplení, které motor nesmí přesáhnout. 

Oteplení motoru jako takové vzniká ze ztrát. Ztráty v motoru dělíme na mechanické ztráty způsobené 

třením a vlastní ventilací, ztráty Jouleovy a ztráty v železe. Jelikož jsou největší ztráty způsobené u 

motorů v železe a ve vinutí, zaměříme se hlavně na ně. Ztráty v železe se přitom odvádějí menším 

tepelným odporem než ztráty ve vinutí, z tohoto důvodu je u RSM rozhodující oteplení statorového 

vinutí. Rotor RSM oproti ASM nemá žádné vinutí, proto se ani neuvažuje, že by rotor způsoboval nějaké 

ztráty vinutím [13]. 

Dovolené oteplení se dělí podle normy ČSN EN 60034-18-21 ed. 2 na šest teplotních tříd: A, E, B, 

F, H, N. Hodnota dovoleného oteplení určuje teplotu, kterou nesmíme překročit při provozu motoru, 

aby nedošlo ke zrychlenému stárnutí izolace použité v motoru. Pokud by při zkoušce či simulaci vyšlo 

najevo, že oteplení převyšuje předem danou třídu, je zapotřebí zvýšit třídu izolace a případně také najít 

nový materiál, jelikož plechy většinou mají pouze jednu danou třídu izolace. Zvýšením třídy izolace se 

zvýší i dovolené ztráty ve vinutí, neboť, jak už bylo zmíněno, oteplení způsobují hlavně ztráty ve 

statorovém vinutí. Konkrétní hodnoty teplot pro jednotlivé teplotní třídy jsou uvedené v následující 

tabulce [14]. 

Tab. 1: Tepelné třídy dle ČSN EN 60034-18-21 ed. 2 převzato z [14]. 

Jmenovitá tepelná třída 
Tepelná třída 

(°C) 

105 (A) 105 

120 (E) 120 

130 (B) 130 

155 (F) 155 

180 (H) 180 

200 (N) 200 
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1.5.1 Chlazení 
Při překročení dovoleného oteplení by došlo ke zrychlenému stárnutí izolace a tím pádem i 

motoru. Aby se tedy motor udržel pod dovolenou hodnotu oteplení, je zapotřebí motor nějakým 

způsobem chladit. Jedním ze základních rozdělení chlazení je na chlazení pasivní a chlazení aktivní. 

Při pasivním chlazení je teplo ze stroje odváděno přirozenou konvekcí a zářením. Tím pádem je 

tento způsob chlazení nenáročný, neboť nepotřebujeme chlazení nijak vnucovat. Druhou možnosti je 

vlastní chlazení, kdy je většina tepla odváděna nucenou konvekcí. Využitím ventilátoru nebo čerpadla 

vnucujeme proudění chladícího média, které teplo z motoru odvádí. Výhodou oproti pasivnímu 

chlazení je samozřejmě vyšší účinnost. Naopak nevýhodou je potřeba chlazení „vnucovat“, tedy využít 

určitý dodatečný příkon pro funkci chlazení [15]. 

 V případě RSM nižších výkonů přichází v úvahu hlavně chlazení s využitím vlastní ventilace. Na 

společnou hřídel je tedy připojen ventilátor, který se otáčí společně s rotorem, podobně jako u 

asynchronních motorů. 

2. Modelování synchronního reluktančního motoru 
V této kapitole je popsáno samotné modelování RSM. Návrh je nejprve proveden ve vývojovém 

prostředí Ansys RMxprt. Toto prostředí nabízí možnost návrhu nejčastějších typu motorů. Je zapotřebí 

začít volbou typu motoru, poté se musí zadat konstrukční rozměry a vinutí motoru. Nakonec se zadají 

počáteční hodnoty pro analýzu a po kontrole správnosti návrhu je možné simulaci provést. 

2.1 Silokřivky magnetického toku 
Návrh a simulaci modelů motorů jsem se rozhodl po konzultaci s vedoucím práce provést ve 

vývojářském prostředí Ansys Electronics Desktop. Vzor pro stator RSM byl převzat z modelu 

asynchronního motoru. Jednotlivé hodnoty rozměrů statoru a vinutí jsou uvedeny v manuálu pro ASM 

od firmy Ansys [16]. 

Výměnou pouze rotoru a ponecháním původního statoru umožníme též částečné porovnání 

vlastností RSM s původním ASM. 

Aby se vytvořil rotor RSM, je zapotřebí znát průběh silokřivek magnetického toku motoru. Pro 

jejich zobrazení využiji RMxprt a Maxwell 2D obsažené v programu Ansys Electronics Desktop. Ve 

vývojářském prostředí RMxprt jsem však neobjevil možnost rotoru bez bariér, proto jsem vytvořil rotor 

s velmi malou bariérou pro zobrazení silokřivek ve zbytku rotoru, jak můžeme vidět na Obr. 4 a Obr. 5. 

Obr. 4: Část rotoru pro zobrazení silokřivek magnetického toku. 
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Obr. 5: Zobrazení silokřivek magnetického toku. 

2.2 RMxprt 
Program RMxprt nabízí širokou škálu různých vzorů pro vytváření modelu točivých strojů. Pro 

tvorbu samostatné konstrukce je zapotřebí zvolit v Design Flow možnost Generate RMxprt Solutions. 

Dále v sekci Machine Type zvolím General a vyberu mezi Synchronous Machines položku Reluctance 

Synchronous Machine. Vývojářské prostředí poté připraví vzor motoru pro zadání rozměrů a hodnot 

navrhovaného RSM. 

2.2.1 Návrh statoru 
Při návrhu statoru využiji rozměry statoru ASM zmiňovaného v části 2.1. Při zvolení položky 

Stator v RMxprt se mi zobrazí okno pro zadávání hodnot (Obr. 6). Nejprve si zvolím počet pólů a poté 

počet drážek. Dále je zapotřebí si zvolit typ zapojení a poté tvar drážky. RMxprt také pro přehlednost 

nabízí grafické zobrazení daného zapojení vinutí a tvaru drážky. Při volbě se otevře malé okénko, kde 

je možné změnit typ zapojení a poté se zobrazí grafická podoba. 

Obr. 6: Okno pro návrh statoru RSM s vyobrazením typu zapojení. 
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Obr. 7: Zvolený typ drážky. 

Nyní následuje vyplnění rozměrů statoru. Volbou položky Core, která se nachází pod položkou 

Stator, se otevře další okno. Začnu volbou vnějšího průměru statoru a poté vnitřního průměru. Dále 

zadám délku statoru, která bude stejná i pro rotor. Zde je také možné si zvolit materiál, ze kterého je 

stator vyhotoven. Pro moji simulaci jsem si z rozsáhlé databáze zvolil materiál M19_29G, který je 

typickou ocelí pro elektrotechniku. Pokud by bylo zapotřebí, je také možné vlastnosti daného materiálu 

ručně upravit změnou hodnoty parametrů materiálu. 

V dalším kroku zadám hodnoty drážky pro vinutí statoru (Obr. 8). Volbou položky Slot pod 

položkou Core si otevřu okno rozměrů. Na Obr. 7 vidíme, co jednotlivé symboly představují. 

Obr. 8: Rozměry drážky statoru. 

Po zadání všech hodnot rozměrů statorů se můžeme vrátit zpět volbou položky Stator a můžeme 

si povšimnout, že RMxprt vykreslil konečnou podobu statoru (Obr. 9).  

Obr. 9: Stator navrhovaného RSM. 
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2.2.2 Návrh vinutí 
Po zhotovení statoru přichází na řadu návrh vinutí statoru. V položce Winding si otevřu opět 

okno pro zadání parametrů (Obr. 10). Vinutí jsem zadal jednovrstvé s jednou paralelní větví. Materiál 

jsem zvolil měď při 75 °C, přesněji copper_75C. 

Obr. 10: Parametry vinutí statoru 

RMxprt po návrhu vinutí vytvoří také grafickou podobu statorového vinutí. Je možné si zde 

zobrazit fáze vinutí v drážkách a jejich zapojení volbou možnosti Connect all coils (Obr. 11). Toto 

zobrazení zapojení vinutí budu moci také využít později při zadávání geometrie vinutí v programu 

Motor-CAD. 

Obr. 11: Vinutí statoru pro navržený RSM. 

Po několika simulacích jsem však narazil na problém s vinutím statoru dle původního ASM. 

Zaplnění drážky statoru bylo u původního ASM pouze 14 %, což způsobovalo mnohé potíže s výpočty 

a simulacemi. Bylo tedy zapotřebí vinutí statoru pozměnit, aby bylo možné RSM simulovat. Na Obr. 10 

tedy vidíme nové vinutí statoru pro RSM. 

2.2.3 Návrh TLA rotoru 
Poslední částí návrhu ve vývojovém prostředí RMxprt je rotor motoru. Rotor RSM jsem vytvořil 

ve dvou provedeních. V prvním případě se jedná o rotor TLA jak ukazuje Obr. 12. Aby RSM správně 

fungoval, je zapotřebí v sekci Rotor zvolit stejný počet pólů. Dále v sekci Core zadám hodnoty rozměrů. 

V tomto případě jsem opět zvolil rozměry podobné jako má ASM, podle kterého byl navržen stator. 

Tato možnost se nabízí, neboť se může u ASM vyndat rotor a vymění se za RSM rotor, který by měl mít 

podobné rozměry [11]. 
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Obr. 12: Šestipólový TLA rotor. 

2.2.4 Návrh bariéry 
Bariéru rotoru jsem se rozhodl zvolit typu hyperbolic-polyline, přestože tento tvar bariéry 

neodpovídá nejlépe tvaru silokřivek magnetického toku. Tento typ bariéry jsem zvolil, aby bylo možné 

později v Motor-CAD zadat podobnou strukturu. Velikost vzduchové mezery bariéry jsem se snažil 

přizpůsobit podle průběhu silokřivek. 

Optimalizace rozměrů bariéry by sice byla možná, ale z časového hlediska této práce 

neproveditelná. Proto je využita možnost Barrier Auto Arrangement, kterou RMxprt nabízí (Obr. 13). 

Stačí tedy zvolit pouze rozměry první bariéry a zbylé bariéry se automaticky navrhnou pomocí 

programu (Obr. 14). 

Obr. 13: Rozměry bariéry. 



11 
 

Obr. 14: Volba rozměrů v RMxprt. 

2.2.5 Návrh Cut-Off rotoru 
Jako druhým rotorem pro porovnání vlastností jsem zvolil rotor typu Cut-Off (Obr. 15). Jelikož je 

zvolena možnost automatického návrhu zbylých bariér, bylo zapotřebí rozměry první bariéry zvolit tak, 

aby program u poslední vnější bariéry vytvořil strukturu Cut-Off.  

Obr. 15: Šestipólový TLA s Cut-Off rotorem. 

3. Výsledky analýzy RMxprt 
Po vytvoření modelu už zbývá pouze nastavit analýzu modelu. V sekci Analysis si vytvoříme 

Setup1, do kterého zadáme parametry motoru. Můžeme zde také změnit název analýzy pro 

přehlednost, pokud bychom chtěli vytvořit několik verzí. 

Pro analýzu RSM je zapotřebí zvolit výkon, pro který bude RMxprt hledat výsledky analýzy. 

Jelikož RSM pracuje při 45° zátěžného úhlu, zvolil jsem danou hodnotu výkonu pro jednotlivé verze 

RSM. Napětí jsem nastavil na 400 V a otáčky na 1000 ot/min. Frekvenci jsem zadal na 50 Hz. 

Zaškrtnutím políčka Enabled jsou hodnoty analýzy připraveny [17]. 
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Před samotnou analýzou je ještě zapotřebí nejprve nechat zkontrolovat, zda jsou zadané údaje 

rozměrů a analýzy v pořádku. V horní liště se zvolí RMxprt -> Validation Check a program zkontroluje 

design a nastavenou analýzu. 

Pokud bylo po kontrole vše v pořádku, je nyní možné v liště zvolit RMxprt -> Analyze All. RMxprt 

poté podle zadaných hodnot provede simulaci navrženého motoru. 

Výsledky analýzy pak získáme přes Setup1, volbou Performance. Zde se zobrazí okno analýzy a 

je možné zjistit vlastnosti navrženého motoru (Obr. 16, 17, 18). V liště Performance je pak možné si 

zobrazit data analýzy o vlastnostech motoru pro porovnání. Můžeme si zde všimnout například 

požadovaného výkonu při 1000 ot/min či účinnosti. Na Obr. 16 a 17 je vidět, že motor s TLA rotorem 

je zatížen výkonem 11,64 kW a Cut-Off rotor výkonem 12,27 kW. Obě varianty jsou procentuálně na 

svůj výkon zatíženy stejně, neboť mají stejný zátěžný úhel. 

Obr. 16: Výsledky analýzy pro TLA rotor. 
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Obr. 17: Výsledky analýzy pro Cut-Off rotor. 

Obr. 18: Výsledky analýzy pro původní ASM. 
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Volbou složky Curves je také možné si zobrazit křivky analýzy. V křivce výkon/zátěžný úhel na Obr. 19 

vidíme, že RSM opravdu pracuje při 45° zátěžného úhlu. 

Obr. 19: Křivka výkon/zátěžný úhel. 

3.1 Účiník 
Porovnáním výsledných hodnot z Obr. 16, 17, 18 vidíme, že z analýzy RMxprt vyšel účiník v obou 

případech nižší než u ASM. U TLA rotoru je účiník přibližně o 0,198 nižší než u původního ASM. U Cut-

Off rotoru je účiník o 0,195 nižší. 

3.2 Účinnost 
Naopak účinnost RSM rotorů je vyšší než u původního ASM. Jelikož RSM nemá na rotoru žádné 

vinutí, nebude RSM mít ani ztráty ve vinutí rotoru. U TLA rotoru můžeme zaznamenat účinnost 

přibližně o 5,91 % vyšší než u původního ASM. V případě Cut-Off rotoru je účinnost vyšší o 5,66 %. 

3.3 Moment 
Jako třetím parametrem z analýzy si můžeme u momentu povšimnout vyšší hodnotu v případě 

RSM oproti původnímu ASM. Zde došlo k zvýšení hodnoty o 21,7 N∙m u TLA rotoru oproti původnímu 

ASM. Cut-Off rotor má moment vyšší o 27,7 N∙m, avšak obě verze RSM odebírají také vyšší proud. 

4. Vytvoření 2D modelu 
Nyní je na řadě z vyhotovených návrhu modelů RSM vytvořit 2D model ve vývojovém prostředí 

Maxwell 2D. Poté, co se model vytvoří, bude následovat nastavení analýzy pro tranzientní simulaci 

obou motorů. Analýzu motorů budu provádět bez rozběhu, důvod bude vysvětlen níže. 
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4.1 Maxwell 2D 
Vytvoření Maxwell 2D modelu je v programu Ansys Electronics Desktop propojené 

s vývojářským prostředím RMxprt. Program totiž nabízí přímo možnost dle RMxprt vzoru vytvořit 

automaticky Maxwell 2D model (Obr. 20, 21). Podle již zadané analýzy se zvolí Setup1 -> Create 

Maxwell Design -> Type: Maxwell 2D Design a poté se v Maxwell 2D model vytvoří automaticky. 

Obr. 20: Model pro RSM s TLA rotorem. 

Obr. 21: Model pro RSM s Cut-Off rotorem. 
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4.2 Nastavení analýzy 
Aby bylo možné obdržet výsledky z modelu motoru, je zapotřebí nastavit tranzientní 

magnetickou analýzu. V horní liště zvolíme Maxwell 2D -> Solution Type -> Magnetic: Transient. 

Ještě je zapotřebí nastavit zobrazení magnetického toku, aby analýza tok simulovala současně. 

Nejprve označím celý model pomocí Edit -> Select All a poté kliknutím pravého tlačítka myši na model 

zvolím Fields -> A -> Flux lines. Nakonec již stačí v okénku In Volume zvolit AllObjects. 

U samotné analýzy ještě nastavíme dobu a krok simulace, ve všech případech jsem si nastavil 

dobu ukončení simulace na 0,2 s a krok 0,0002 s. S takto nastaveným krokem obdržíme dostatečně 

detailní průběh pro jednotlivé simulace a analýza také nebude trvat příliš dlouho. Simulace je také 

schopna automatického rozpoznaní ustáleného stavu, tedy při ustálení křivek proudů a napětí 

ukončuje analýzu. 

Aby bylo možné vidět magnetický tok v různých dobách, je zapotřebí ještě v nastavení analýzy 

zvolit čas pro ukládání rozložení magnetického pole. V sekci Save Fields zvolíme volbu Custom a 

uložíme Linear step s krokem, který jsem si nastavil na analýzu. V případě potřeby je také možné čas či 

krok poupravit. 

Počáteční poloha rotoru je přednastavena pomocí RMxprt při vytváření modelu na 40 stupňů. 

Maxwell2D nabízí možnost přímo přepsat mechanický úhel natočení. Tato možnost je pro uživatele 

mnohem jednodušší než nastavovat jak mechanický úhel natočení, tak i elektrické napájení. Aby se 

zátěžný (elektrický) úhel rovnal mechanickému úhlu, musel bych mít dvou-pólový stroj. Jelikož mám 

šesti-pólový stroj, je zapotřebí elektrický úhel vydělit počtem pólpárů, abych obdržel mechanický úhel 

natočení: 

𝜃𝑚 =
𝜃𝑒
𝑝𝑝
. (4-1) 

Tedy pro zátěžný úhel 45° je zapotřebí mechanické natočení 15°. Požadovanou hodnotu 

počáteční polohy lze jednoduše změnit, stačí zvolit Model -> MotionSetup1 a upravit hodnotu Initial 

Position. 

Pro vytvořené modely v Maxwell 2D odpovídá 26° mechanického úhlu natočení přibližně 0° 

zátěžného úhlu, kdy je moment nulový. Pro simulaci zátěžného úhlu 45° je tedy zapotřebí nastavit 

mechanický úhel natočení na 41°. 

V MotionSetup1 je také možné v sekci Mechanical zaškrtnout Consider Mechanical Transient 

pro simulaci rozběhu motoru. V takovém případě by analýza počítala s momentem setrvačnosti, 

tlumením a zátěžným momentem. Hodnota momentu setrvačnosti je programem vypočítána, a poté 

je možné hodnotu využít při analýze. Pro reálnou simulaci by bylo vhodné také zvolit zátěžný moment 

záporný, aby byla simulace pro motor a ne generátor, ale z časových důvodů jsem možnost Consider 

Mechanical Transient nezaškrtnul. Simulace v takovém případě není až tak časově náročná na analýzu 

a počítá s pevně danou hodnotou rychlosti otáčení již z počátku, jedná se vlastně o analýzu ustáleného 

stavu. 

Nakonec je ještě zapotřebí upravit kvalitu sítě modelů. Maxwell 2D při automatické tvorbě 

počítá pouze s přibližně 2 000 elementy pro celý motor. To je však příliš málo elementů pro popis 

geometrie a vzájemného pohybu sítě při rotaci. Proto jsem pro rotor a stator nastavil alespoň 10 000 

elementů a pro vzduchovou mezeru též. U vzduchové mezery jsem také nastavil maximální velikost 
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elementu na půlku její velikosti. Stačilo pouze zvolit hodnoty přes Asign Mesh Parameters -> Inside 

Selection -> Length Based. 

Před zahájením samotné analýzy je pak zapotřebí obdobně jako při analýze v RMxprt nejprve 

provést kontrolu všech zadaných hodnot a správnost modelu. V horní liště se zvolí položka Maxwell 

2D -> Validate all, a poté, co proběhne v pořádku kontrola, bude možné provést analýzu. Pro zobrazení 

výsledku analýzy je možné předem nastavit, jaké průběhy budeme chtít zaznamenávat. Maxwell 2D 

však již při vytváření modelů připravil několik průběhů, které se budou zaznamenávat, pokud je 

nesmažeme. Z předem připravených průběhů, které budu analyzovat, využiji průběh momentu a 

průběh proudu na všech třech fázích.  

5. Výsledky analýzy Maxwell 2D 
Analýza má otáčky rotoru pevně nastavenou na hodnotu 1000 ot/min, přitom není nastaven 

výpočet elektromechanického přechodového děje, a tudíž dochází pouze k výpočtu 

elektromagnetického přechodového děje. Rozběh motoru tedy není zohledněn a po přibližně dvou 

periodách dojde k ustálení proudů. Právě z rychlosti ustálení průběhů si můžeme všimnout, že se 

opravdu nejedná o rozběh motoru, neboť by k ustálení při rozběhu došlo až po několika periodách. 

Přesto v analýze dochází na počátku k velkým špičkovým hodnotám, a proto je zapotřebí 

ustálené hodnoty určit až v oblasti ustálení. V programu Maxwell 2D je možné hodnoty získat z průběhu 

jednoduše volbou možnosti Trace Characteristics -> All. Zde si vybereme hodnoty, které budeme chtít 

zobrazit. V dolní části v sekci Value vybereme možnost Specified a zadáme počáteční čas pro zobrazení 

a konečný čas. Označením funkce a výběrem možnosti Add Trace Characteristic se v pravém horním 

rohu v legendě u jednotlivých průběhů zobrazí hodnota z daného časového úseku. 

5.1 Proudy 
Z analýzy vyšla efektivní hodnota proudu přibližně 27,48 A pro TLA rotor (Obr. 22). Pro Cut-Off 

rotor jsme obdrželi efektivní hodnotu proudu okolo 29,22 A (Obr. 23). Cut-Off rotor však má výkon o 

0,63 kW vyšší než TLA rotor, což způsobuje také vyšší efektivní hodnotu proudu. Tyto hodnoty jsou pro 

zátěžný úhel 45°, pro menší zátěžný úhel obdržíme také menší efektivní hodnoty proudů. 

Výsledné hodnoty proudů si zapamatujeme, jelikož budeme moct hodnoty proudů později využít 

v Motor-CAD pro výpočet ztrát ve statorovém vinutí. 

Obr. 22: Průběh proudů v čase pro TLA rotor. 
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Obr. 23: Průběh proudů v čase pro Cut-Off rotor. 

ASM sice nemá zátěžný úhel, ale stále můžeme porovnat velikost proudu s hodnotami proudů u 

navržených RSM (Obr. 24). Na první pohled si můžeme povšimnout, že u původního ASM není žádná 

deformace křivky proudu, průběh je sinusový a hladký. U RSM je deformace proudu pravděpodobně 

způsobena neoptimalizovanou konstrukcí rotorů. 

Obr. 24: Průběh proudů v čase pro původní ASM.  

5.2 Moment 
Porovnáním průběhů momentu (Obr. 25, 26, 27) vidíme, že v případě Cut-Off rotoru je větší 

zvlnění momentu. Toto zvlnění je pravděpodobně způsobené strukturou rotoru, která není hladká. 
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Obr. 25: Průběh momentu v čase pro TLA rotor. 

Obr. 26: Průběh momentu v čase pro Cut-Off rotor. 

Obr. 27: Průběh momentu v čase pro původní ASM. 
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U průběhu momentu pro TLA rotor vidíme, že zvlnění momentu dosáhlo až přibližně 68 %. 

Cut-Off rotor má větší zvlnění momentu přibližně 74 %.  

Obr. 28: Průběh momentu pro TLA rotor s výkonem 91 kW. 

Pro porovnání jsem si také vytvořil motor s výkonem přibližně 91 kW, na Obr. 28 tedy vidíme, že 

je zvlnění momentu přibližně 47 %, tedy došlo ke snížení zvlnění přibližně o 21 %. 

5.3 Magnetický tok 
Jelikož jsem si již připravil v nastavení analýzy Maxwell 2D položku Field, stačí pouze vybrat 

v záložce View -> Set Solution Context a vybrat čas ze záznamu. Na Obr. 28 a Obr. 29 můžeme vidět, 

jakým způsobem se silokřivky magnetického toku uzavírají přes vytvořené cesty. Jak již bylo zmíněno 

v části 1.3.2, můstky ve vzduchových bariérách jsou také cestou, přes kterou přechází silokřivky 

magnetického toku. Dále si z obrázků můžeme povšimnout, že struktura má opravdu šest pólů jak pro 

stator, tak pro rotor. 

Obr. 29: Silokřivky magnetického toku pro TLA rotor. 
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Obr. 30: Silokřivky magnetického toku pro Cut-Off rotor. 

6. Tepelný model v Motor-CAD 
V této kapitole je popsána simulace v programu Motor-CAD. Bude zapotřebí opět vytvořit 

geometrii obou navržených konstrukcí. Po zadání rozměrů proběhne nejprve analýza modelu 

E-Magnetic, aby se získaly potřebné hodnoty pro výpočet ztrát motorů. Dle těchto hodnot bude pak 

možné provést simulaci dovoleného oteplení v ustáleném stavu. Na konci této kapitoly pak proběhne 

diskuze ohledně dovoleného oteplení a způsoby, jakými se s příliš velkým oteplením vypořádat. 

6.1 Model RSM 
Pro zkoumání dovoleného oteplení bylo zapotřebí využít programu Motor-CAD. Ansys 

Electronics Desktop sice nabízí možnost exportovat navržený motor z vývojářského prostředí RMxprt, 

avšak při exportu navrženého modelu se objevila chyba, kterou se mi bohužel nepodařilo vyřešit. Proto 

jsem musel geometrii navržených motorů ručně zadat do programu Motor-CAD a poté provést analýzu 

dovoleného oteplení. 

Abych se mohl pokusit o vytvoření geometrie motorů, musel jsem z vývojářského prostředí 

Maxwell 2D exportoval DXF soubor, který jsem importoval pomocí File -> Geometry Import -> Select 

File -> Display do programu Motor-CAD. Po volbě správného DXF souboru jsem obdržel obrys 

geometrie navrženého modelu RSM a bylo možné v Motor-CAD upravovat hodnoty rozměrů podle ní. 

Konstrukční možnosti rotoru jsou v Motor-CAD pevně dané, v tomto případě je při výběru typu 

rotoru Interior U-Shape tvar bariéry pouze hyperbolic-polyline. Pokud bych chtěl analyzovat konstrukci 

rotoru typu hyperbolic-curve, bylo by zapotřebí správně nastavit geometrii importem z RMxprt. Jelikož 

jsem však narazil na problém s exportem navrženého motoru, který se mi nepodařilo vyřešit, zvolil 

jsem tvar bariéry hyperbolic-polyline (Obr. 30). 

Cut-Off strukturu jsem se také pokoušel ručně zadat (Obr. 31). Podařilo se mi strukturu přibližně 

vytvořit, avšak není zcela přesná, neboť ocel poslední bariéry je stále v malém měřítku „připevněná“ a 

není “uříznutá” (Obr. 3). 
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Obr. 31: Navržená přibližná struktura TLA rotoru. 

Obr. 32: Navržená přibližná struktura Cut-Off rotoru. 

Vinutí pro RSM se zadává trochu jinak než V RMxprt, ale pomocí možností si zobrazit, jak vinutí 

vypadají v RMxprt, jak již bylo zmíněno v části 2.2.2, je možné podobné vinutí navrhnout i v Motor-

CAD. Po zadání geometrických rozměrů a vinutí je možné ještě návrh motoru zkontrolovat v axiálním 

průřezu, a dokonce ji zobrazit jako 3D model. 

Při analýze E-Magnetic jsem pak narazil na další problém. Pokud nechám v Motor-CAD 

importovanou geometrii z DXF souborů program přejde z analytického řešiče na FEA řešič. Ten však 

má problém s geometrií, kde se protínají výpočetní body statoru s výpočetními body vzduchové mezery. 
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Abych tento problém odstranil, je zapotřebí importovanou geometrii upravit v softwaru. Musím také 

původní DXF soubor odstranit, abych mohl upravenou verzi opět vložit. V sekci Geometry Import tedy 

zvolím možnost Clear DXF file. 

DXF soubor jsem si poté otevřel v Ansys HFSS a upravil jsem si ho tak, aby mi zbyl pouze rotor. 

Takto upravenou verzi DXF souboru již bylo možné opět importovat do Motor-CAD a využít k výpočtu. 

Analýzou E-Magnetic modelu pak získáme hodnoty ztrát, které se automaticky importují do Thermal 

modelu motorů. 

6.2 Tepelná analýza 
V horní liště volbou Model je možné přepnout z E-Magnetic modelu na Thermal. Můžeme si 

povšimnout, že se změnilo prostředí programu. Podobně jako v elektromagnetickém modelu je možné 

si opět zobrazit geometrii v radiálním nebo axiálním průřezu a jako 3D model. 

Motor-CAD umožňuje počítat mnoho typů výkonové zátěže, například trvalou zátěž či 

krátkodobou zátěž. V mém modelu byla zvolena možnost trvalé výkonové zátěže, a tudíž je možné 

zanedbat tepelné kapacity jednotlivých částí motoru. 

V ustáleném provozu platí, že teplo vzniklé ztrátami je rovno odvedenému teplu z motoru. K 

tomu je zapotřebí znát jak ztráty motoru, tak tepelný odpor motoru. Ztráty motoru jsem již získal, a 

sice ze simulace v E-Magnetic modelu. Tepelné odpory pak můžeme získat ze simulace v Thermal 

modelu. 

Abych mohl provést tepelnou analýzu, budu muset opět zadat potřebné hodnoty. V tomto 

případě se jedná hlavně o chlazení motoru. 

6.2.1 Chlazení 
V geometrii si mohu vybrat způsob chlazení motoru. Jelikož mám RSM nižšího výkonu, v úvahu 

přichází, jak již bylo zmíněno v části 1.5.1, hlavně chlazení pomocí vlastní ventilace.  Po zvolení varianty 

chlazení je možné vidět v axiálním průřezu, že ventilátor pro vlastní chlazení se již připevnil na 

společnou hřídel. V dalším kroku tedy zadám parametry pro chlazení. Jelikož máme vlastní chlazení, 

zadáváme pouze směr průtoku chladícího vzduchu a rychlost proudění vzduchu. Máme zde také 

možnost nastavit otvory krytu pro proudění vzduchu mimo motor. 

Přibližnou hodnotu potřebného průtoku chladícího vzduchu na uchlazení motoru je možné 

vypočítat z kalorimetrické rovnice: 

�̇� = �̇� ∙ 𝑐 ∙ ∆𝑇. (6-1) 

Pro určení hodnoty objemového toku chladícího vzduchu má Motor-CAD defaultně nastavenou 

hodnotu rychlost vzduchu protékající průřezem kolem rotoru. Z kalorimetrické rovnice si mohu 

vypočítat hmotnostní průtok, z něhož po vydělení hustotou obdržím objemový průtok. Abych obdržel 

správnou hodnotu vstupu, objemový průtok ještě vydělím průřezem, čímž dostanu hodnotu průtoku v 

m/s, tedy potřebnou rychlost. Druhou možností je nastavit v simulaci, aby se místo rychlostního toku 

využil objemový průtok. Pak už není potřeba hodnotu přepočítávat na rychlost průtoku, stačí pouze 

hmotnostní průtok vydělit hustotou. 

Nyní již stačí pouze přejít k analýze. Zde si zvolím možnost importování údajů o ztrátách 

z elektromagnetického modelu a nechám program provést analýzu dovoleného oteplení nastavením 

analýzy pro steady state (trvalé zatížení). Teplota okolí je přitom nastavená na 40 °C. 
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6.3 Výsledky analýzy 
Analýza proběhla při stejném zátěžném úhlu 45° a chlazení s průtokem 15 m/s pro obě varianty 

rotoru. Výsledky analýzy dovoleného oteplení si můžeme zobrazit v několika variantách. 

Nejpřehlednější možnosti jsou zobrazení radiálního a axiálního řezu motoru, kde můžeme vidět 

v rámečcích označení dosažené teploty u jednotlivých částí motoru. 

Obr. 33: Teploty v ustáleném stavu bez chlazení pro TLA rotor. 

Pokud bychom nastavili hodnotu průtoku chladícího vzduchu na 0 m/s, získáme tím nejvyšší 

možnou teplotu, kterou motor dosáhne při vypočtených ztrátách (Obr. 32). Vidíme, že bez chlazení by 

motor měl příliš vysokou teplotu a nevydržel by. 

Obr. 34: Teploty v ustáleném stavu s průtokem 15 m/s pro TLA rotor. 
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Podle tepelné třídy E je dovolené oteplení statorového vinutí pouze 80 °C. Aby nedošlo 

k překročení nejvyšší možné průměrné teploty vinutí pro třídu E, je zapotřebí nastavit průtok chladícího 

vzduchu na 15 m/s. Analýzou poté vidíme, že se pro průtok chladícího vzduchu rychlostí alespoň 15 

m/s průměrná teplota vinutí udržuje pod 120 °C (Obr. 33). 

Pokud bychom tedy chtěli ještě více snížit oteplení motoru, bylo by zapotřebí zvýšit jeho chlazení 

nebo změnit způsob chlazení. Jak však již bylo poznamenáno, RSM oproti ASM nemá vinutí na rotoru, 

proto také rotor nepřispívá ohmickými ztrátami k oteplení. Hlavní část, kterou je třeba chladit, je tedy 

stator motoru, které je stejné jako u původního ASM. 

Tento fakt si můžeme ověřit porovnáním teplot na rotoru a na statoru. Vidíme, že na statoru je 

velmi vysoká teplota způsobená ztrátami ve vinutí. Zde je také nejvyšší teplota. Naopak směrem do 

středu se teplota snižuje. Nejnižší teplota je pak uprostřed na hřídeli, kdy rozdíl teplot je přibližně 32 °C. 

Pokud nemůžeme změnit způsob chlazení nebo zvýšit chlazení motoru, pak se zde nabízí 

možnost vyměnit typ izolace motoru za izolaci s vyšší třídou dovoleného oteplení. V takovém případě 

by se třída dovoleného oteplení zvýšila o jednu třídu z E na B, a tím by se rozsah dovoleného oteplení 

zvýšilo o dalších 10 °C. Nicméně motor by zřejmě musel být kvůli účinnosti zatěžován, jako by měl 

izolaci třídy E. 

V případě rotoru s Cut-Off strukturou je odebíraný proud o 1,74 A vyšší než u TLA rotoru. Bez 

chlazení je nejvyšší teplota způsobená statorovým vinutím vyšší než u TLA rotoru (Obr. 34). Je tedy 

zapotřebí znovu počítat průtok chladicího vzduchu, neboť bude hodnota oteplení vinutí vyšší než u 

první varianty. Pokud zadáme průtok 15 m/s a necháme Motor-CAD tepelnou analýzu znovu provést, 

pak si můžeme povšimnout, že teplota již přesáhla hranici dovoleného oteplení pro třídu E (Obr. 35). 

Teplota rotoru je však v obou případech nižší v porovnání se statorem. V obou případech totiž jsou 

ztráty vytvářeny pouze ve statoru. 

Obr. 35: Teploty v ustáleném stavu bez chlazení pro Cut-Off rotor.  
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Obr. 36: Teploty v ustáleném stavu s průtokem 15 m/s pro Cut-Off rotor.  
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7. Závěr 
V této bakalářské práci jsou porovnány dva modely srovnatelných synchronních reluktančních 

motorů odlišné konstrukce. Úkolem práce bylo modely motorů vytvořit ve vývojovém prostředí Ansys 

Electronics Desktop, poté provést jejich simulaci, ověřit správnost návrhu motoru, a nakonec oba typy 

konstrukce mezi sebou porovnat. Vytvoření modelu a simulace původně proběhla pomocí RMxprt a 

Maxwell 2D. Po konzultaci s vedoucím práce bylo rozhodnuto ještě v programu Ansys Motor CAD 

provést tepelnou simulaci, která by byla v případě návrhu motoru nezbytná. 

Nejprve jsem v první kapitole krátce popsal, co to je reluktanční moment, poté jsem popsal typy 

rotorů RSM, následně jsem se ještě krátce zmínil o některých kvalitativních parametrech motoru. Ke 

konci kapitoly jsem popsal problémy s dovoleným oteplením a způsoby, jak se s nimi vypořádat. 

Samotný návrh RSM modelu jsem provedl nejprve v RMxprt. Rozměry statoru jsem převzal 

z ASM a vinutí též. Po vytvoření statoru následoval návrh rotoru RSM. Největší problém představoval 

návrh bariér, což je předmětem mnoha výzkumných prací. Optimalizace bariér rotoru RSM je sice 

možná, ale jelikož simulace jedné podoby rotoru může trvat velmi dlouho, nebylo to v rámci této práce 

proveditelné. 

Po simulacích několika variant RSM jsem narazil na problém s původním vinutím ASM. Plnění 

drážek vinutí statoru bylo velmi nízké, pouhých 14 %, a pro RSM nedostačující. Musel jsem proto vinutí 

statoru pozměnit, aby simulace mohly správně proběhnout. 

Z vyhotovených modelů RSM bylo možné v RMxprt provést analýzu správnosti motorů. Výsledky 

analýzy obou RSM jsem poté porovnal mezi sebou. Jelikož mají RSM podobný stator jako původní ASM, 

provedl jsem také porovnání vlastností s ASM, aby byla vidět změna vlastností výměnou rotoru ASM 

za rotor RSM. 

Po analýze v RMxprt jsem vytvořil Maxwell 2D model pro další analýzu. Zde jsem nastavil 

tranzientní magnetickou analýzu a zadal jsem krokování simulace. Z výsledných průběhů jsem opět 

provedl porovnání obou RSM a původního ASM. 

Při zaškrtnutí možnosti Consider Mechanical Transient by se simuloval rozběh motoru. Analýza 

by zahrnovala moment setrvačnosti, tlumení a zátěžný moment. Všechny tyto hodnoty jsou sice 

důležité pro výpočet reálného chování rozběhu motoru, avšak nejsou v mém případě zapotřebí. Při mé 

simulaci se snažím ukázat, že motor dokáže nějaký moment vyvinout, a proto jsem analýzu provedl bez 

možnosti Consider Mechanical Transient. Se zaškrtnutím možnosti by také simulace trvala příliš dlouho. 

Nakonec jsem ještě v Ansys Motor CAD provedl tepelnou simulaci. Bylo zapotřebí nejprve 

v Motor CAD ručně vytvořit konstrukci již navržených motorů. Poté se vybral způsob chlazení a zadaly 

se její parametry. 

Z výsledků jednotlivých analýz vycházelo, že RSM má účinnost 94,38 % v případě TLA rotoru a 

94,13 % v případě Cut-Off rotoru. Oproti původnímu ASM má TLA rotor vyšší účinnost o 5,91 % a 

Cut-Off rotor o 5,66 %. Tyto hodnoty jsou dosaženy díky konstrukci RSM, kdy rotoru zcela chybí 

rotorové vinutí, a proto má menší ztráty. Díky této skutečnosti RSM nemá ani velké oteplení rotoru, 

teplota se zvýšila hlavně v důsledku tepla od statoru. Oproti původnímu ASM mají navržené modely 

RSM také vyšší moment, který byl 21,7 Nm pro TLA rotor a 27,7 Nm pro Cut-Off rotor. Účiník byl však 

v obou případech nižší než u ASM. Aby se získala vyšší hodnota účiníku, byla by možnost do 

vzduchových bariér vložit permanentní magnety, tím by se však cena rotorů výrazně zvýšila. 
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Z výsledků RMxprt se jevila konstrukce Cut-Off rotoru velmi podobná TLA rotoru, dokonce i o 

trochu lepší. Z analýzy v Maxwell 2D ale vyplynulo, že tato konstrukce není vhodná kvůli jejím 

vlastnostem. Zvlnění momentu bylo u Cut-Off struktury přibližně o 6 % větší než u TLA rotoru. Obě 

varianty rotorů však měly velmi vysoké zvlnění momentu. Tento jev je hlavně způsoben geometrií 

rotorů, kdy reluktance není konstantní. Úpravou geometrie by tedy bylo možné značně snížit zvlnění, 

proto je také mnoho prací zaměřených právě na optimalizaci geometrie. Pro větší výkon či jiné vinutí 

je zvlnění momentu také nižší. Na porovnání jsem vyzkoušel upravit vinutí statoru pro vytvoření 

motoru s výkonem přibližně 91 kW, zvlnění se snížilo až o 21 % (Obr. 28). 

U obou RSM si také můžeme povšimnout menší deformace průběhů proudů. To je oproti 

původnímu ASM nevýhodou, neboť je proud v ASM sinusový a zcela hladký. 

U tepelné analýzy bych řekl, že v simulaci dovoleného oteplení se mi nepodařilo přesně vytvořit 

stejnou konstrukci rotorů, kterou jsem měl v Ansys Electronics Desktop. Bylo to způsobené hlavně 

časovou náročnosti tvorby modelů a simulace v obou programech. Osobně si myslím, že pokud budu 

mít více času, mohlo by se mi podařit nastavit lepší geometrii pro analýzu. 

Jelikož má Motor-CAD předdefinované analytické řešení pro výpočet elektromagnetického pole, 

pokusil jsem se alespoň o řešení, kdy jsem se snažil předělat návrh geometrie motoru, pokud možno 

co nejpodobnější konstrukci obou rotorů, abych mohl provést analytický výpočet. Z analýzy těchto 

geometrií jsem pak obdržel výsledky pro zadání hodnot do simulace. Z analýzy tedy vyšlo, že pokud 

bychom motor nechladili vůbec, teplota by mohla dosáhnout až 233,2 °C. S průtokem chladícího 

vzduchu o rychlosti 15 m/s je pak možné motor zchladit do dovoleného oteplení pro tepelnou třídu E. 

Nejvyšší průměrná teplota vinutí v tomto případě je 119,6 °C. 

Tento výsledek z tepelné analýzy vyšel pro variantu TLA rotoru. Varianta s Cut-Off rotorem 

odebírala vyšší proud, a proto vytvářel vyšší ztráty ve statorovém vinutí. Pro průtok chladícího vzduchu 

o rychlosti 15 m/s dokonce dochází k překročení dovoleného oteplení tepelné třídy E. Je zde tedy 

zapotřebí zvýšit tepelnou třídu či změnit způsob chlazení. 

Tepelná analýza pomocí programu Motor-CAD pro původní ASM nebyla provedena, neboť se 

jedná o konstrukci, která byla převzata. Dá se tedy očekávat, že při původním návrhu tohoto motoru 

již tepelná analýza úspěšně proběhla. 

V závěru bych chtěl říci, že výsledky získané ze simulace v RMxprt, Maxwell 2D a Motor-CAD byly 

dostačující pro porovnání rotorů RSM. Analýza však z časových důvodů nebyla v této práci provedena 

zcela kompletně pro rozběh motorů, kde by byly prozkoumány reálné fyzikální vlastnosti. Vytvořené 

rotory také nevykazují nejlepší vlastnosti, avšak cílem práce bylo porovnat dvě základní provedení 

rotorů. Lepších vlastností bych mohl dosáhnout změnou geometrie a případně i úpravou vinutí statoru. 

K tomu by však byla zapotřebí parametrická studie, která se po mně nechtěla. Nabízela by se proto 

možnost navázat v budoucnosti na tuto práci optimalizací geometrického provedení rotorů pro 

zlepšení pracovních parametrů motorů.  
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